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Introduction

Did you know that radio waves are like the secret messengers of the electromagnetic
spectrum? They're invisible, can travel through walls and zip through the atmosphere
to deliver information from one place to another, even to and from outer space! With
the help of devices like radio receivers, we can pick up these secret messages and
convert them into sounds that our ears can understand or even dance to!

But not all radio waves are created equal. Just like how everyone has their own
unique dance moves, radio waves have different frequencies and wavelengths that
determine their special powers. Some are used for playing your favourite tunes or
getting the latest news, while others are reserved for important communication
between devices and machines, like when your phone talks to the nearest cell tower.

Radio technology has been rocking our world for over a century, and it's not slowing
down anytime soon! Whether it's helping us stay entertained, or getting data from
orbiting satellites like EIRSAT-1, radio is the superhero of the communication world.

You have already learned a bit about radio and its importance in your previous
activities, however, this next activity will take it to the next level. Through the power
of software-defined radio (SDR), we are going to open the door and help you see an
invisible universe that's all around you. Once you have your SDR set up, we will
show you how to receive & see signals, including from orbiting weather satellites.

An Electromagnetic (Radio) wave consisting of an electric E field and a magnetic H field, showing their oscillations as the wave
propagates. Source: Irish Radio Transmitters Society Study Guide 2023
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What is Software-Defined Radio (SDR)?
Imagine you're a DJ at a party, and you've got a magical turntable that can play any
kind of music you want, just by changing its settings. That's kind of like what an SDR
is - it's a radio that can "tune in" and receive any kind of frequency or signal, just by
changing its software settings.

With traditional radios, you'd need a different physical device to receive different
parts of the radio spectrum and for each type of signal you want to send or receive.
With SDR you just need a small device (a dongle) to receive a slice of the radio
spectrum and software to make it work for any kind of frequency or signal type.

The SDR dongle in your pack is a “wide-banded” radio receiver. It can receive a slice
of the radio spectrum from 24MHz to 1700MHz (1.7GHz); the area between the two
red lines below. Compare this to your kitchen or car radio that can typically receive
between 87.5MHz & 108MHz (approx). There are more expensive SDR dongles that
can receive much more of the spectrum (typically from 0hz - >2.5GHz). But our little
dongle is more than capable for what we need to do.

Just like how you don't need to be a DJ master to use a turntable, you can easily
operate an SDR with user-friendly software that lets you switch between different
frequencies. The best part is that SDR makes all these once-invisible radio signals
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come to life on your screen - you can see the invisible EM spectrum! In this activity,
we are going to help you get to know one type of SDR software called SDR#
(SDR-Sharp) for Windows. So, whether you want to listen to the radio, track planes
in the sky, or even communicate with satellites in space, an SDR can make it happen
- no magic wand required!

An SDR spectrum scope & “Waterfall” - look at all those radio signals!

What we’re going to do
This activity is all about helping you decode a radio signal from space. In your
previous activities, you learned about Ireland's first satellite, EIRSAT-1. EIRSAT-1 is
a cube satellite. There are lots of cube satellites already in orbit sending signals back
down to earth.

However, unless you have the right antenna, cube satellites are tricky to detect. This
is mainly because they transmit their radio signals at low power and are moving very
fast. If you have an antenna that is designed to pick up weak signals (a high gain
antenna) and it can rotate and track the satellite, you’ll receive that satellite very well,
right? Unfortunately, there are other variables that make cube satellites difficult to
receive. So even if you built your fancy high gain antenna, there are no guarantees…
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NOAA 19
Weight 1.5 Ton, Length 4.2m
(as big as a family car!).
Transmit Power = 5 Watts

EIRSAT-1
Dimensions: 22 cm x 10 cm x 10 cm
(about the size of a milk carton)
Transmit Power = <1 Watt

What we need is a satellite, with a strong radio signal, that can be reliably received
by the simple antenna in your kit. This antenna is called a V-Dipole (an antenna with
two legs shaped like a V). Fortunately, the US National Oceanic and Atmospheric
Administration (NOAA) have a number of large weather satellites, with high-power
transmitters - your V-Diople can receive these. NOAA satellites are constantly
orbiting and imaging our planet; simultaneously beaming those images back to earth
using radio. All you need to know is when these satellites are passing overhead, set
up your SDR and antenna to receive real-time images of earth from space!

A rotatable/tracking antenna for satellites

A simple V-Dipole antenna - you’ll be using one
of these!
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About NOAA satellites
How do NOAA satellites collect data?

The images transmitted by NOAA satellites are produced by the satellite's primary
scanning instrument called the Advanced Very High-Resolution Radiometer
(AVHRR). The instrument is designed to detect five channels of radiant energy from
the surface of the Earth ranging from the visible spectrum to the near-infrared and
infrared or thermal spectra. As the satellite passes over a given part of the earth, the
AVHRR sensors collect and transmit data in near-real time. Think of the satellite as
scanning Earth's surface line by line. In the resulting images, each pixel is
approximately 4 × 4 km.

How do they transmit data?

The NOAA satellites have inbuilt radio antennas that transmit the data collected by
the AVHRR instrument on a frequency in the 137 MHz range. To minimise
interference between satellites, each NOAA satellite transmits on a different
frequency within the 137 MHz range.
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How do NOAA satellites orbit?

NOAA satellites orbit the Earth sun-synchronously. A sun-synchronous orbit is a
nearly polar orbit in which the satellite passes over a given point of the planet's
surface at the same time every day. The NOAA satellites follow a Low Earth Orbit
(LEO). A LEO is an Earth-centered orbit with an altitude below 2,000 km. Each
satellite circles the Earth approximately every 100 minutes.

Source: ESA 2023
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Getting Started

In your weather satellite kit box you’ll find all the hardware required for this project,
namely; an SDR dongle, cable, and various antenna components. You’ll also need a
laptop or PC.

To help you get up and running with your Weather Satellite station, we’ve put
together the following quick start guide. If you find you’re getting bogged down
installing the software, please click on the YouTube video links provided… they'll
walk you through all the steps! We have also included the SDR# guide in the
appendix (p28).

Step 1: Assemble your kit

1. Connect your antenna to your RF cable (aka Coax cable). (If you need to
assemble your antenna do this first).

1. Assemble the antenna as shown 2. Use supplied bracket to set antenna legs to 120
degrees.Orientate North to South when in final

position.
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3. Connect RF/Coax cable to antenna and the SDR.
Length of cable depends on where your antenna

will be situated

4. Choose the antenna mount that suits best.
Antenna outside in always better.

Set both your antenna legs to a length of 53.4cm, 120o apart, parallel to the
ground (Horizontal). The “point” of the V should point North.

About your Antenna: The size of an antenna is an essential factor in how well
it can send and receive electromagnetic waves. To work properly, the length of the
antenna needs to match the wavelength of the signal it's working with. We can get
the length of an antenna by dividing the speed of light by the desired operating
frequency of the antenna. NOAA satellites transmit their radio signals at a
frequency (f) of around 137,000,000 Hertz (Hz) and the speed of Light (c) is
300,000,000 metres per second. Let's knock off a few zeros to make this easier!

Antenna Length calculation: L (Length in metres) = (c) 300 / (f) 137 = (L)
2.12m

Our V-Dipole antenna has two wire elements (legs), so we divide by two to get the
length of each leg = 1.06m. This antenna seems a little big for a classroom!
Luckily, antennae also work well on fractions of wavelengths like halves, and
quarters. This property is called “Harmonics”. This is handy and keeps antenna
sizes manageable!

So our half-wavelength V-Dipole antenna would be

L = 147 / f(MHz)

L = 147 / 137.5

L = 1.068m = 106.8cm

Each leg = 53.4 cm

For more info see IRTS Study Guide: IRTS – Amateur Radio in Ireland, Irish Radio Transmitters Society
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2. Screw the coaxial cable into the non-USB side of the dongle (Be careful not to
over-tighten the cable connector as they are easily damaged. No more than
finger-tight)

3. This is the basic setup that you will use to decode weather satellite images. In
order for this setup to become operational, you need to follow the steps below to
install and run the software. It's a good idea to leave your dongle unplugged for now.

Step 2: Install a virtual audio cable

1. Download and install a virtual audio cable VB Cable for Windows

2. Follow the install instructions on the application's website.

Installing VB audio cable video Tutorial
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Step 3: Set up your SDR software

If you are using SDR# for Windows, follow these steps:

1. Download and install SDR#. Since SDR# involves a batch installer that
requires an exchange of drivers, please refer to the SDR# Quick Start Guide in
the Appendix (p25).

SDR# start-up window

2. Plug your dongle into a USB port. Launch SDR#.

3. Select your Dongle type. Use the arrow to Select Source > [RTL-SDR USB]

4. Set the Audio Samplerate. In the left panel, scroll down to view the Audio
settings. Select Samplerate > 192,000 sample/second. Sample Rate is dependent
on your PC's soundcard, so it may be that 192,000 sample/sec is not available, in
which case try selecting a lower sample rate, like 48,000 sample/sec.
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5. Adjust Audio Input and Output settings. Make sure the audio input is your
computer's sound card. Make sure the audio output is your virtual audio cable.

6. In the Audio section, make sure to uncheck the 'Filter Audio' box.

7. Start receiving: Click the Play button at the top left of the window.

8. Tune to a frequency: In the frequency display box, click on the upper half of each
number to increase, and the lower half to decrease frequency. You can also click,
drag and scroll through frequencies using the waterfall display.

Changing frequency in SDR#

9. Changing Modes: click bubbles labelled AM, NFM, WFM, USB, LSB, CW at the
left panel to change the mode in which data is demodulated by the software. For
receiving transmissions from NOAA satellites, ChooseWFM or "Wide FM".

Selecting modes in SDR#
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10. Adjusting Bandwidth: in the left panel, find the window for bandwidth; use your
number keys or the small up / down arrows to increase or decrease bandwidth. For
receiving satellite transmissions, select a bandwidth between 36,000 - 45,000 Hz.

🔧 You can also use your mouse: in the waterfall display, click on the edge of the
frequency range and drag left or right to manually increase or decrease bandwidth.

11. Adjusting Volume: drag the Volume slider to increase or decrease.

🔧 Other settings in SDR# can remain in default modes; For example, the Filter in
SDR# can remain Blackman-Harris 4.

If you get stuck, please look at this SDR# Installation Video it will walk you
through the installation steps.

When operating, the SDR Dongle will get warm to touch - that's OK.
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Step 4: Set up WXtoImg, your satellite decoding software

WXtoImg is a fully automated APT (Automated Picture Transfer) and WEFAX
weather satellite (wxsat) decoder. The software supports recording, decoding,
editing, and viewing on all versions of Windows, Linux, and macOS. WXtoImg
supports real-time decoding, map overlays, advanced colour enhancements, 3-D
images, animations, multi-pass images, projection transformation (e.g. Mercator),
text overlays, automated web page creation, temperature display, GPS interfacing,
wide-area composite image creation and computer control for many weather satellite
receivers. You can download WxtoImg here. https://www.wraase.de/wxtoimg/

Please note there are two pieces of software to download here, the preconfigured
decoder software and the Kepler data software. The web page is self-explanatory

1. Download and install WxtoImg https://www.wraase.de/wxtoimg/ .

When you first launch WXtoImg, you will be taken through a series of steps to tailor
the software to your computer. Go through the steps. Then follow the instructions
below.

2. Assigning your Ground Station Location. Select Options > Ground Station
Location (you can either search for a city or input your latitude and longitude
manually)
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3. Update Keplers. Open Kepler Updater for WxtoImg. Select Update Kepler
Data (It is good to update Keplers before every satellite decoding session to
maintain accuracy). Minimise and go back to WxtoImg.

4. Adjust the Map Overlay settings. Select Options > Map Overlay Options

💡 You can choose in what colour you would like the map to appear and ground
station to appear, or choose to hide them)

5. Adjust the Recording Options: Select Options > Recording Options

● In the dialogue box that appears, select your chosen virtual audio cable.
Select Soundcard > [Your Virtual Audio Cable]

● Choose 16 as the sample rate.
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● Elevation settings for receiving satellite signals can be left at default; Select
what kind of antenna you are using from the Antenna Type list.

WXtoImg: Recording Options Dialogue Box

6. Checking the Satellite Pass List: Select File > Satellite Pass List. This will
generate a window with upcoming times at which NOAA satellites will pass over your
ground station location)

💡 FM or frequency modulation is the encoding of information in a carrier wave by
varying the frequency of the wave. In AM or amplitude modulation, information is
encoded in the amplitude (signal strength) of the carrier wave.

Step 5: Test that WXtoImg can 'hear' your SDR software

1. Tune to an FM radio station (around 100 Mhz) using your preferred SDR software

🔧 Since you are piping the audio coming from the SDR software to WXtoImg with a
virtual audio cable you should not be able to hear the station through your computer
speakers. If you can hear the station, adjust your Audio Output.
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2. In WXtoImg, Select Record > Manual Test.

3. Do lines filled with tiny dots or speckles start loading in the WXtoImg window? If
so, WXtoImg can hear your radio software and the audio connection is working.

WXtoImg attempting to decode FM radio static

4. In the bottom right, is the volume level green? If it is 'in the green' this means the
signal is in a good range for decoding. If it is not green (e.g. if it is red or yellow)
adjust the volume on your SDR software until the WXtoImg volume becomes green.

Step 6: Decoding an image from a satellite pass

Important to know:

When is the next 'good' satellite pass over your location?

A 'good' pass is a pass that is more than 10 minutes long. In the Satellite Pass list,
Duration is measured in minutes. In the Satellite Pass list generated by WXtoImg,
find the next 11+ minute pass.

Satellite pass list in WXtoImg

🔧 the list shows Local Time and UTC Time. Take note of the difference.

18



What direction is the satellite travelling?

In the Satellite Pass List, note whether the satellite is Northbound or Southbound.
Also note whether the satellite will be to the east or west of you, and at what
maximum elevation. For example, a NOAA 15 Southbound pass at 49W MEL
(Maximum Elevation) means the satellite is travelling south and at its max elevation
(mid-way through the pass) it will be 49 degrees out of 90 (where 90 is directly
overhead) to the west. When using a V-Dipole antenna like that in your "V-dipole
antenna kit" you should keep the antenna parallel to the ground with a north-south
orientation (and the two antenna 'legs' 120 degrees apart both facing South).

What frequency will the satellite be transmitting on?

Make sure to note down the frequency of your chosen satellite pass (see the
rightmost column in the Satellite Pass List where Frequency is listed in MHz).

Where can you best receive this transmission in your local area?

The transmission is best received from a wide open area with a good horizon. This
could be a park, a parking lot, a rooftop, a hill, a beach or a balcony (as long as the
balcony has a clear view of the path of the satellite)

Pre-satellite pass checklist

● Are you tuned to the frequency of the satellite?
● Are you using a 36,000--45,000 Hz bandwidth and demodulating with Wide

FM (SDR#)
● Is your SDR software sending audio to WXtoImg (see above steps for testing

that they can hear each other)?
● Are you pointing/orienting your antenna in the right direction?

In SDR# the waterfall display can freeze or stutter. If this happens simply close the
programme and reopen it, keeping your dongle plugged in.

Receiving your first satellite transmission

1. A few minutes before the pass is due to start. On WXtoImg Select File > Record
> Record and Auto Process > Create Image(s) > Auto Record; When the satellite
passes over the elevation you designated in the Recording Options dialogue box,
you should start receiving a signal.

2. The satellite signal looks like a faint series of dots and dashes that will begin to
appear on the waterfall display of your SDR software;
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Traces in the SDR# waterfall display

3. When you see the satellite signal, adjust the frequency (if needed) so that the
SDR / radio software is centred on the signal. This might mean increasing the
frequency by 1 or 2 MHz

4. Adjust for the Doppler shift. The frequency of the transmission 'drifts' from a little
higher than the satellite's designated frequency to a little lower than the designated
frequency. During the pass adjust for this Doppler shift by using the arrows or
dragging in the waterfall display to keep the radio software centred on the satellite
signal.

5. When using an antenna like a V-Dipole you need to pay attention to orientation:
keep the antenna parallel to the ground with a north-south orientation (and the two
antennae 'legs' 120 degrees apart both facing South).

You will see a marked difference in signal strength on the waterfall display if you are
pointing the antenna in the right direction vs. the wrong direction.

6. Periodically check WXtoImg to make sure the volume is green and the pass is
being decoded.
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WXtoImg window: live-decoding a satellite image from NOAA 19

7. When the pass is over, WXtoImg will begin to automatically process the raw data.
You will see the software 'working' as it combines information from different sensors
to produce a series of b/w and colour images. When it is done processing 'Done' will
appear in the bottom left of the window.

8. Stop WXtoImg from waiting for the next satellite by selecting File > Stop.

9. The image you have just received will be stored in the Raw Images tab. You can
double-click on the raw image of the pass and then use the Enhancements menu to
look through the different combinations of sensor data.

10. The raw image and audio file unique to this pass will also be saved in WXtoImg's
'Raw' and 'Audio' folders on your computer.
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Congratulations on your first attempt!

WXtoImg enhancements

Troubleshooting

My satellite decoding software loads a black image during the test

This means there is something wrong with the connection between your SDR / radio
software and WXtoImg. You need to double-check all of the connections and virtual
audio cables. Double-check the Audio Output on your SDR software and the
Soundcard (Audio Input) in WXtoImg.
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The volume is in the red, close to 0 during the test

This means that the signal coming into WXtoImg is far too quiet for WXtoImg to
process it. Turn up the volume on your SDR software. If this doesn't work there may
be an issue with the audio inputs and outputs connecting the SDR software to
WXtoImg.

On MacOS, check that the Master volume for Soundflower is not turned down.

1. Application > Utilities > Audio MIDI Setup
2. In Audio MIDI Setup, select Soundflower (ch2)
3. Drag the level of the Master volume to the maximum value, usually 1

Alternative Guides for Decoding Weather Satellite Images

● RTL-SDR Tutorial: Receiving NOAA Weather Satellite Images
● Martin Bernardi's Guide to Receiving NOAA Images
● Alex Wuff's How to Download Live Images from Government Weather

Satellites

Satellite Tracking Websites

A fun thing to do is tracking the satellites you’re aiming to receive. Tracking websites
also give a good indication as to where the satellite is relative to your position. As
previously stated, you may receive a weak signal if your antenna is not pointing
along the North-South track of the satellite pass. For example, knowing that the
satellite is approaching from the South East or South West and slightly adjusting
your antenna accordingly will make a difference! There are a number of these
websites, we’ve posted the links to two below. Searching by the satellite’s name is
usually enough.

https://www.satflare.com/search.asp https://www.n2yo.com/?s=43678
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Other things you can do with an RTL-SDR

About your Antenna: For the weather satellite exercise we orientated the
antenna horizontally (parallel to the ground). However, if you want to scan for
ground-to-ground signals (like those listed below), we recommend that you
orientate the antenna vertically. Many earth-based radio services, like FM radio,
airport or maritime communications etc use vertically orientated/polarised
antennae. A receiving antenna that matches the orientation of the transmitting
antenna generally works better. There is a thing called circular polarization… but
we won’t get into that!

The RTL-SDR can be used as a wide-band radio scanner. Applications include:

Listening to EMS/Ambulance/Fire communications - (Frequency List)

Characterising RF filters and measuring antenna SWR.

Decoding aircraft ACARS (Aircraft Communications Addressing and Reporting
System) - 129MHz to 132MHz.

Decoding Amateur Radio APRS packets (Automatic Position Reporting) - 144.8MHz

Decoding Inmarsat STD-C EGC geosynchronous satellites.

Decoding POCSAG/FLEX pager traffic.

Decoding taxi mobile data terminal signals.

Decoding unencrypted digital voice transmissions such as P25/DMR/D-STAR.

Listening to aircraft traffic control - (Frequency List)

Listening to and decoding HD-Radio (NRSC5).

Listening to DAB broadcast radio

Listening to FM radio, and decoding RDS information.

Listening to satellites

Listening to the ISS (International Space Station).

Listening to VHF/UHF amateur radio (Frequency List).

Monitoring meteor scatter
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Radio astronomy.

Receiving GPS signals and decoding them.

Receiving NOAA weather satellite images - 137MHz

Receiving wireless temperature sensors and wireless power meter sensors.

Reverse engineering unknown protocols.

Searching for RF noise sources.

Tracking aircraft positions like a radar with ADSB decoding.

Tracking and receiving meteorological agency-launched weather balloon data.

Tracking maritime vessel positions like a radar with AIS decoding.

Tracking your own self launched high altitude balloon for payload recovery.

Triangulating the source of a signal.

Use rtl-sdr as a high-quality entropy source for random number generation.

Use rtl-sdr as a noise figure indicator.

Use rtl-sdr as a panadapter for your traditional hardware radio.

Using rtl-sdr as a spectrum analyser.

Using rtl-sdr on your Android device as a portable radio scanner.

Watching analogue broadcast TV.

Furthermore, with an upconverter or V3 RTL-SDR dongle to receive HF signals
the applications are expanded to:

Decoding digital amateur radio communications such as CW/PSK/RTTY/SSTV.

Listening to amateur radio hams on SSB with LSB/USB modulation.

Listening to international shortwave radio.

Looking for RADAR signals like over-the-horizon (OTH) radar, and HAARP
signals.

Receiving digital radio mondiale shortwave radio (DRM).

Receiving HF weather fax.
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Appendix 1. Quick Start Installation of SDR# (SDR-Sharp).

SDR# is a popular SDR program for Windows that's easy to set up and use with an
RTL-SDR dongle. Here's how to get started:

1. Make sure you have Microsoft .NET 6.0 x86 Desktop Runtime installed.
2. Download sdrsharp-x86.zip from www.airspy.com and extract it to a folder on

your PC.
3. Double-click on install-rtlsdr.bat in the extracted folder to download the

required drivers for SDRSharp to work with RTL-SDR.
4. If install-rtlsdr.bat fails to download the necessary files, do a manual driver

installation.

Note that SDR# is incompatible with XP and Vista, and the community-managed
edition may be broken.

If install-rtlsdr.bat fails to download the dll or zadig, do a manual driver
installation. If Zadig is smaller than 5000kB (5MB), the download has failed and
you should download Zadig manually.

To set up your RTL-SDR dongle with SDR#, follow these steps:

5. Plug in your dongle and wait for plug and play to finish attempting to install the
dongle.

6. If you've already installed the DVB-T drivers that came with some dongles,
uninstall them first.
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7. Find the file called zadig.exe in the folder where you extracted the SDR sharp
files and run it as administrator.

8. In Zadig, make sure the "Options->List All Devices" option is checked. On
Windows 10 or 11, you may also need to uncheck "Ignore Hubs or Composite
Parents" in some cases

9. To set up the dongle, plug it in and wait for it to install, then run zadig.exe from
the folder where you extracted the SDR# files. Make sure "List All Devices" is
checked and select "Bulk-In, Interface (Interface 0)" from the dropdown list, or
something like RTL2832UHIDIR or RTL2832U. Double-check that the USB ID
shows "0BDA 2838 00". Do not select anything else in Zadig or you may
overwrite another device's driver. To install the WinUSB driver, make sure
WinUSB is selected in the box after the arrow next to "Driver". The left-hand
box is not important.

10.After selecting the WinUSB driver and verifying that the USB ID is "0BDA
2838 00", click on "Replace Driver" to install the drivers needed to use the
dongle as an SDR. You may see a warning about the publisher not being
verified, but you can click "Install this driver software anyway" to proceed.

Great, you're all set up now! A couple of things to keep in mind as you start using
your RTL-SDR:
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11. Be sure to use an appropriate antenna for the frequency range you're trying to
receive. The dipole antenna included in your kit is a good all-around option,
and we can adjust its length to detect NOAA satellites.

12. In SDR#, you can use the "Frequency Manager" plugin to save and organize
the frequencies you want to listen to.

13.You can also use plugins like "Frequency Scanner" to automatically scan a
range of frequencies for activity.

14.Experiment with the gain settings in SDR# to find the best balance between
sensitivity and signal-to-noise ratio.

Have fun exploring the world of software-defined radio! At this stage, you can
connect the antenna to the SDR dongle, start SDR# and start scanning the
spectrum. You should do this to familiarise yourself with SDR#. You can find a
shortened version of the SDR# Users Guide in appendix 1. You will find the full
version here: rtl-sdr.com/SDRSHARP . We show how to connect up the Antenna om
page. There is also a Dipole Antenna Guide: rtl-sdr.com/DIPOLE - Learn how to
use your RTL-SDR Blog multipurpose dipole antenna.

Important! Adjusting the RF gain is important to get the best performance out of
the RTL-SDR dongle. It can be a bit tricky to find the right balance between gain and
noise, but it's worth experimenting with different settings to see what works best for
your specific use case. The gain is set to zero on first installation, you will need
to change this to begin hearing signals, try halfway at first!
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Appendix 2. SDRSharp Users Guide

SDR# is currently the most popular SDR program used with the RTL-SDR. It's easy to set up and use.
To install SDR#, go through our Quickstart Guide. Below we explain some of the settings and displays
in SDR#.

Upon opening SDR# you'll be greeted with the screen shown below. Here we have highlighted the
main parts of SDR#

After opening SDR# for the first time, we suggest that you immediately remember to perform the
following steps (if you don’t know what some of these steps are, continue reading further below for
more information):

1. Increase the RF gain from zero to a higher value in the configure menu.
2. Reduce the range slider on the right of the SDR# window to about -70 (for RTL-SDR

dongles).
3. Enable the “Correct IQ” setting to remove the center spike if using an R820T/R820T2, or

enable “Offset Tuning” in the configure menu if using an E4000/FC0012/13.
4. Turn off the “Snap to grid” setting, or adjust the PPM offset accordingly.
5. Set the 'Mode' to the correct setting for the signal that you are listing to.

Main Settings and Windows

Note that there is a distinction in SDR# between settings that affect the software side and settings that
affect the hardware side. All hardware side settings can be found in the Configure Menu window

which can be accessed with the cog icon . In here are settings to control things like the RF gain
and sample rate/bandwidth of the RTL-SDR. To optimize reception, you need to adjust settings in this
window.
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Most of the settings found in the main windows of SDR# affect the software digital signal processing
(DSP) side of things. To optimize the processing of the signal you need to adjust these DSP settings.

Control/View Explanation

Play Button /
Stop Button

This button is used to start and stop the SDR.

Source This is a drop-down menu which is used to select the SDR input device being
used. If you are using an RTL-SDR, select RTL-SDR/USB. Be sure to NOT
select RTL-SDR/TCP unless you are using a remote server with rtl_tcp.

Configure
Menu

Clicking this button opens up the configure menu. In here you can change
settings like the sample rate (bandwidth) and RF gain. See further down for more
information about these settings.

Frequency
Input

Use the mouse to set the desired frequency you wish to listen to here. You can
either click on the tops and bottoms of each individual number to increase or
decrease the value, or simply hover over the number you want to change and
use the mouse wheel to alter the value.

The frequency input is divided into 4 sections with each section containing 3
values (e.g. 000.000.000.000). The first section represents GHz frequency
values, the second MHz, the third kHz and the last Hz. For example, to tune to a
radio station at 88.6 MHz we would enter 000.088.600.000 into the frequency
input. To tune to 861.5475 MHz we would enter 000.861.547.500. To tune to
1.575 GHz we would enter 001.575.000.000. To tune to 500 kHz (with an
upconverter and appropriate offset shift set (discussed later)) we would tune to
000.000.500.000.

Volume Set the volume level of your output speakers or audio piping device here.

RF Spectrum /
FFT Display

This part of the window shows the RF spectrum as a graph in real-time visually.
Active signals will appear as peaks on this graph.

RF Waterfall This part of the window shows the RF spectrum graph spread over time with new
data at the top and old data at the bottom, just like a waterfall.
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Tuning Bar The vertical red line in the RF spectrum graph shows where on the RF spectrum
the RTL-SDR is currently tuned to. Within the currently active chunk of
instantaneous bandwidth, the tuning can be altered by simply using the mouse to
click and drag the red line, or just by clicking elsewhere in the RF spectrum.

The shaded rectangular area around the red line shows the bandwidth of the
tuned area (don’t confuse this with the bandwidth/sample rate that is set in the
configure menu). The bandwidth should be set so that it covers the area of the
signal that is tuned. The bandwidth can be adjusted by using the mouse to
simply drag the edges of the shaded area in or out.

Radio Tab

Here you can choose what type of demodulation mode the signal at your currently tuned frequency
should use.

Mode Acronym
Expansion

Explanation

NFM Narrowband
Frequency
Modulation

Commonly used mode used by walkie talkie radios, weather
radio and most VHF/UHF digital signals.

WFM Wideband
Frequency
Modulation

This is the mode that broadcast FM stations use (e.g. radio
music stations).
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AM Amplitude
Modulation

Used by broadcast AM stations that are receivable by normal
shortwave radios and also used by air band voice frequencies
used by aircraft and air traffic control. Some digital signals also
use AM.

LSB/USB Lower Side Band /
Upper Sideband

Used in the HF band by ham radio users to transmit voice and
data efficiently with small bandwidths.

CW Continuous Wave Used for listening to Morse code.

DSB Double Side Band Similar use to AM, but requires centered tuning.

RAW Raw IQ signal Used for listening or recording RAW IQ data

Setting Suggested
Default

Explanation

Shift 0 (No
upconverter
used)

This box offsets the tuned frequency by the amount entered. This
is useful if you are using an upconverter. For example if you have
an upconverter with a 100 MHz oscillator, you would set the shift to
be -100,000,000 (don’t forget the minus sign). Without the shift,
when using an upconverter to tune to a signal at 9 MHz you would
need to actually tune to 100 + 9 = 109 MHz. With the shift set, you
can tune to 9 MHz as normal. If you have an upconverter with a
125 MHz oscillator you would tune to 125 + 9 = 134 MHz, or set
the shift to -125,000,000.

Bandwidth NFM/AM:
12500, WFM:
250000

This is the width of the shaded part of the tunable area. You can
set it manually here, or by dragging the edges with the mouse as
described under the tuning bar description.

Filter Blackman-Ha
rris 4

Changes the filter type used. Different filters have different shapes.
The filter is used to select the highlighted signal in the RF window.
Blackman-Harris is usually the best filter to choose and this setting
almost never needs to be changed.
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Order 500 Changes the filter order. You may notice when using low filter
orders that signals outside of the tuned bandwidth can still be
heard. Larger filter orders “tighten” or “sharpen” the band pass filter
used within the tuned bandwidth/IF thus preventing signals outside
of the tuned bandwidth from being heard. You will want to increase
the filter order when there are strong signals near to your tuned
area. Using higher filter orders can cause a greater load on the
CPU, so slow PCs may need to reduce this value.

Squelch OFF Squelch is used to mute the audio when the signal strength is
below the specified value. A larger value requires a stronger signal
to unmute the audio. It is useful for when listening to speech as the
sound of static when no one is talking will be muted.

CW Shift 600 Mainly useful for when receiving CW (Morse code) as it specifies
the offset between CW transmit and receive frequencies.

FM Stereo OFF Will enable stereo output for broadcast radio WFM signals, but can
make weak stations sound worse.

Snap to
Grid / Step
size

OFF or set to
band spacing

In many bands frequencies are allocated at a fixed distance apart.
For instance in most countries air band signals are spaced 25 kHz
apart (or 8.33 kHz in some countries). Turning on snap to grid can
help with tuning by causing the tuning bar to snap directly to a
signal. However, to use this with a non-TCXO RTL-SDR the PPM
frequency offset correction must be set correctly, otherwise the
frequencies may not line up. The snap to step size can be set in
the “Step Size” pull down menu.

Correct IQ ON Should usually be selected as ON. This setting removes the small
but annoying center spike that is present with R820T/R820T2
RTL-SDR dongles.

Lock
Carrier

OFF Only active in AM or DSB mode. Allows for synchronous AM which
can significantly improve reception and also automatically centers
the signal on the carrier. Turn this on for better AM reception, but
may increase CPU usage.

Anti-Fading OFF Can be used when “Lock Carrier” is activated. Takes advantage of
the symmetry of AM signals which helps with weak signals when
they may be fading in and out. Turn this on for better AM reception,
but may increase CPU usage.
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Swap I & Q OFF If you are using SDR# as a panadapter, some hardware radios
may have the I & Q signals swapped and need this option
checked.

Mark Peaks OFF Simply marks any peak in the RF spectrum with a circle.

Audio Tab

This tab allows you to adjust settings related to the audio processing.

Setting Suggested
Default

Explanation

Sample
Rate

48000 Sets the sample rate of your sound card. Some decoding software may
require a specific sample rate to be set. Usually, the default value
should be fine for general listening. This is normally greyed out unless
using a sound card-based SDR.

Input A Sound
Card

Specifies the input sound card when using SDR# with the “Other
(Sound Card)” source. Used mainly with sound card-based
software-defined radios. In normal use with an RTL-SDR, this does not
need to be set.

Output Speakers Sets the audio output device. By default, it is set to your speakers. If
you are passing the audio to a decoder program here you would choose
your virtual audio pipe (VAC/VB Cable) to send the audio to.

Unity
Gain

OFF Should normally be unchecked as it sets the audio gain to 0 dB.
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Filter
Audio

ON Improves voice signals by filtering the audio, removing high-pitched hiss
and DC noise. Should normally be off if decoding digital signals, but
may actually help in some cases if there is a significant DC offset.

AGC (Automatic Gain Control) Tab

Note that in some modes the AGC tab will be greyed out.

Setting Suggested
Default

Explanation

Use AGC ON Turns on the audio automatic gain control. The AGC will attempt to
control the audio volume level so that loud sounds are not too loud
and quiet sounds are not too quiet. The default settings work well
for voice audio signals. It is especially useful to turn this on when
listening to AM/USB/LSB signals as strong signals in these modes
may sound distorted otherwise.

Use Hang /
Threshold /
Decay / Slope

-50, 100, 0 Allows you to modify the default AGC behaviour, though in most
cases the defaults are fine.

FFT Display

The FFT display settings adjust options related to the spectrum analyzer screen and the waterfall.
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Setting Suggested
Default

Explanation

View Both Set it to view both the RF spectrum and the waterfall, or only one of
them, or none at all. Removing the waterfall may be useful on older
PCs with slow-processing hardware.

Window Blackman-H
arris 4

Sets the type of windowing algorithm to use on the FFT, the default of
Blackman-Harris 4 is the best in most cases.
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Resolution 32768 Increasing the resolution will increase the quality of how the signal
looks in the RF display and waterfall. Using a higher resolution may
be useful when fine-tuning, as high resolutions will allow you to see
the peaks and structure of a signal much more clearly. Beware that
high resolutions can slow your PC down and can cause trouble,
especially with single-core machines. Generally, a value of at least
32768 should be used if your PC can handle it.

Time
Markers

OFF Adds time markers on the waterfall display, so you know at what time
a particular signal was broadcasting.

Gradient Allows you to customize the colors used in the waterfall display.

Mark Peaks OFF Adds a circular marker on every signal peak on the RF spectrum.

S-Attack /
S-Decay

Changes the amount of smoothing and averaging done in the RF
spectrum display.

W-Attack /
W-Decay

Changes the amount of smoothing and averaging done in the
waterfall display.

Speed Changes how fast the RF spectrum and waterfall updates.

Zoom FFT

Zoom FFT is a plugin that comes by default with SDR#. It creates a zoomed in RF spectrum display of
the tuned IF bandwidth at the bottom of SDR#.

Setting Explanation

Enable
IF

Opens a “zoomed in” RF spectrum graph around the area of your tuned IF bandwidth.
Allows you to see the signal structure with much greater resolution.
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Enable
Filter

If Enable IF is checked, then you can enable a special adjustable IF filter. This filter
allows you to filter the left and right side of the tuned IF bandwidth individually.

Enable
MPX

Enables you to see the MPX spectrum of a broadcast FM radio station. Broadcast FM is
encoded in a special baseband audio format called MPX. It contains a mono section, a
pilot tone and a stereo section, as well as sometimes subcarrier sections for data like
RDS and special radio services like SCA. If you were to try and view the audio
baseband with the “Enable Audio” button, you wouldn’t see the MPX structure because
SDR# would have processed it into normal audio, and discarded the subcarriers and
other sections.

Enable
Audio

Allows you to see the audio (baseband) spectrum.

SDR# Digital Noise Reduction

It is useful to turn on digital noise reduction when listening to weak and noisy analogue voice signals.
This setting will attempt to reduce the background ‘hiss’ sound. There are two DNR options available,
IF and Audio. The IF uses the noise reduction algorithm on the IF signal and the Audio option does it
on the output audio signal. Usually the IF digital noise reduction works best and should be tried first,
though a combination of both may work best. The sliders control the strength of the algorithm applied,
and the profile can be optimized for the type of audio you are listening to. The profile options are Hi-Fi,
Talk, Speech, Narrow Band and custom.

Noise Blanker

The noise blanker is an algorithm that can be turned on to help reduce impulsive and pulsing like
noise from sources like spark gaps. Examples of this type of noise may come from motors, electricity
lines, power over Ethernet and switching power supplies. Carefully using this option can really help
when receiving a weak signal amongst pulsating noise, which is mostly common on the HF bands.
The noise blanker works by simply removing any samples that have large pulses of energy in them.

In SDR# there are two different types of noise blanker. The baseband noise blanker works on the
entire spectrum and will remove pulses from the FFT and waterfall, whereas the demodulator noise
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blanker only works within the tuned area that is currently being demodulated. Tuning the settings is
mainly an exercise in trial and error. Move the sliders until the pulsating noise goes away, whilst trying
to keep the signal active.

Recording Tab

The recording tab allows you to make I/Q and Audio recordings. The sample format allows you to
choose the level of recording quality needed. Since the RTL-SDR is only about 8-bits, we can select
the lowest 8 Bit PCM option. Using only 8-bits saves a significant amount of disk space.

An I/Q recording is a recording of the entire ~2 MHz bandwidth that you are currently tuned to. It
saves the RF data within the bandwidth so you can replay it at a later time. An I/Q recording can be
made by checking the “Baseband” check box. Note that I/Q recordings can use up a lot of disk space,
so make sure to watch the File Size and Duration status counters. I/Q recordings can be played back
in SDR# by selecting IQ File (*.wav) from the source menu. If you receive a lot of dropped buffers,
then your PC or disk may simply not be fast enough to process the recording. Remember that
baseband recordings use a lot of disk space.

The audio coming out of the speakers can be recorded by checking the “Audio” check box. This will
record audio to a standard audio .wav file. All recorded files are stored in the same folder as the
SDR# executable.
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Frequency Manager Tab

The frequency manager allows you to save any frequencies of interest in a database. A new
frequency can be added to the database by clicking in the New button. This will add a frequency with
the current tuned frequency and settings like bandwidth. You can edit the frequencies name and put it
into a group for easy management. Double clicking on a stored entry will instantly tune SDR# to that
frequency, and set the stored mode and bandwidth.

If you check the “Show on spectrum” check box then your saved frequencies will be displayed in the
RF spectrum.

Right-hand side sliders

The sliders on the right adjust the graph display settings for the RF spectrum and waterfall.

Setting Suggeste
d Default

Explanation
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Zoom Zoomed
out

Moving this slider will cause the RF spectrum and waterfall to zoom in on
your tuned IF bandwidth area in order to see a signal closeup. However,
the more you zoom in, the lower the resolution will seem. An alternative to
zooming is to either reduce the sample rate or to use special decimation
drivers. These alternative methods will preserve the visual resolution and
allow you to see the signal structure much more clearly.

Contrast Adjusts the contrast of the waterfall. Adjust it so that signals clearly stand
out from the background noise.

Range -70 Modifies the dB level range shown on the left (vertical) axis of the RF
spectrum window. You should adjust this so that the noise floor sits near
the bottom of the RF spectrum window. This will allow signals to be more
visible in the FFT RF spectrum and waterfall displays. As the RTL-SDR
has a dynamic range of approximately 50 dB (plus a little more after
oversampling/decimation), you will not need a range much higher than 0
to -70 dB. This setting will also affect the contrast in the waterfall and may
help make weak signals easier to spot.
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Offset 0 Adds an offset to the dB level range in the RF spectrum window. The
offset is added to the top value on the dB level range in the RF spectrum.
Usually, there is no need to adjust this, but if you want to get a really good
contrast on weak signals, adjust this along with the range so that the
signal height is the same height as the vertical axis. This setting will also
affect the contrast in the waterfall and may help make weak signals easier
to spot.

Configure Window / RTL-SDR Controller

The SDR# configure window can be accessed by clicking on the cog icon at the top of the SDR#
window. The settings in this window affect the actual RF performance of the RTL-SDR, and should be
set correctly to optimize the signal-to-noise ratio (SNR). The configure window has several options
which are described below.

Remember that some options may be greyed out until you press stop in SDR#.
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Setting Suggested Default Explanation

Device Your RTL-SDR If you have multiple RTL-SDR dongles plugged in, the
device drop-down menu allows you to choose between
them.

Sample Rate 2.048 or 2.4 MSPS Lets you choose the size of the instantaneous bandwidth
the RTL-SDR should display. Generally, settings of up to
2.8 MSPS work well on most PCs, but if you have a slow
PC you may want to reduce this. We recommend a
default rate of 2.048 or 2.4 MSPS.

Sampling
Mode

Quadrature Sampling Use Quadrature sampling for normal operation. The
direct sampling selections should be used when using an
RTL-SDR that supports it.

Offset Tuning R820T/2 : OFF

E4000/FC0012/13 :
ON

Only useful for the E4000/FC0012/13 tuners. Selecting
this will get rid of the large spike in the centre of the
spectrum that is present with the E4000/FC0012/13 zero
IF tuners.
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RTL AGC OFF Enables automatic gain control on the RTL2832U chip.
This is normally not useful as selecting this usually
degrades reception.

Tuner AGC OFF Enables the automatic gain control system on the tuner
chip. Can be useful for general browsing, but it is almost
always better to set the gain manually.

RF Gain Adjust for best signal
to noise ratio

This slider can be used to set the tuner RF gain
manually. Will not be active if Tuner AGC is checked.

Frequency
correction
(ppm)

TCXO Dongle: 0

Standard Dongle:
Adjust for freq.
accuracy.

Allows you to correct the frequency offset that RTL-SDRs
have from having low quality crystal oscillators.

Setting the RF Gain

There are three RF gain settings that can be found by clicking on the Configure button. RTL AGC
turns on the RTL2832U chips internal automatic gain control (AGC) algorithm. Tuner AGC enables the
RTL-SDR tuners AGC. The AGC’s attempt to automatically optimize the SNR of the signals. Finally,
the gain slider can be used to manually set the gain.

The AGCs used in the RTL-SDR are designed to be used with wideband DVB-T signals, and do not
work very well with narrowband signals. We recommend using manual gain control at all times to
optimize the gain of a signal, however for casual browsing turning on Tuner AGC may suffice. RTL
AGC is almost never used as it tends to just introduce a lot of unwanted noise.

The goal when setting the RF gain manually is to try and get the signal to noise ratio (SNR) as high as
possible. This means that the maximum signal strength should be high, but the noise floor should also
be as low as possible.

When increasing the gain, there will come a point at which the noise floor begins to rise faster than
the signal strength rises. This is the point at which you should stop increasing the gain.

You can calculate the signal to noise ratio by subtracting the peak signal height from the height of the
noise floor.
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What Overload Looks Like

In SDR's (and all radio's for that matter), overload is when a signal that is too strong enters the radio
and causes “saturation”. An analogy might be trying to listen to your friend talking to you at a loud
concert. The music from the speakers is so loud that you can't hear what they are saying. The same
thing can happen in radios. For example, if the SDR cannot cope with a strong signal and starts
overloading, weaker signals will no longer be able to be heard. This can happen even if there is a
strong signal hundreds of MHz away from your target signal, though the closer in frequency it is the
more problematic it will be. The biggest causes of overload are broadcast FM signals, pagers, TV
broadcasts, DAB radio and GSM signals.

The first solution to overload is to simply turn the gain down. But turning the gain down can also make
your desired signal weaker, so ideally you'd use a filter to remove those unwanted strong signals, or
buy a more expensive 12-bit or higher SDR which can handle strong signals much better. In this
section we'll show you what overload looks like on SDR#, so you'll know when to recognize if there is
a problem.

Overload can manifest itself as images of the strong signal at frequencies where they're not meant to
be. For example, in the image below there are broadcast FM stations at 206 MHz, and they definitely
should not be there. Simply turning down the gain causes them to disappear.
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BCFM Images

It can also manifest as a rise in the noise floor. For example in the image below a strong pager signal
is causing the noise floor to rise whenever it transmits, and then fall again when it stops.

Pager Causing Noise Floor Rises
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If you are tuned only a few MHz away from a very strong signal it can cause all sorts of weird images
to show up . For example in this image below, whenever the pager transmits it causes strange signal
spikes all over this part of the spectrum.

Of course overload can also cause the noise floor to rise so high that the signal is no longer visible at
all.

Pager Overload
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Resources used in this guide & Useful links
Decoding NOAA Weather Satellite Images with WXtoImg and SDR# Video
Decoding NOAA Weather Satellite Images with WXtoImg and SDR# - YouTube

DIY 137 MHz WX SAT V-dipole antenna LNA for all: DIY 137 MHz WX SAT
V-dipole antenna

DIY Satellite Ground Station by Public Lab🎈 Public Lab: DIY Satellite Ground
Station How do I start with satellites ? | AMSAT-UK

Irish Radio Transmitters Society (IRTS) HAREC Study Guide IRTS – Amateur
Radio in Ireland, Irish Radio Transmitters Society

NOAA Developing NOAA’s Next-Gen Earth Observation Capability
https://www.nesdis.noaa.gov/s3/2022-05/PWR_SAB_071220212_As_Delivered-rem
ediated.pdf

RTL-SDR & SDR# Install Video Installing RTL-SDR & SDR Sharp on Win10 Made
Easy - TheSmokinApe - YouTube

RTL-SDR A Simple Guide to Setting up a DIY NOAA Weather Satellite Ground
Station

RTL-SDR Blog V3 RTL2832 1PPM TCXO HF BiasT SMA Software Defined Radio +
Antennas | eBay

RTL-SDR Quick Start Guide Quick Start Guide

SDR# User Guide SDRSharp Users Guide

Thingiverse 3D V-Dipole Bracket Thing files for V-Dipole Antenna Bracket
(RTLSDR v3 Kit) by f16v1per - Thingiverse (2)

Want to know more?

Radio is a great hobby and a way to have fun with science and
technology. You can even get an amateur radio licence to transmit
your own radio signals! You can do experiments and communicate
with like-minded people all over the planet by bouncing radio signals
through the ionosphere, satellites and even off the moon! To start your
journey in amateur radio, check out - The National Shortwave Listeners
Club, The Irish Radio Transmitters Society or your local Amateur Radio
Club - like South Dublin Radio Club!
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https://github.com/happysat/Setup-Meteor-M-N2-N2-2-with-LRPT-Decoder-and-MeteorGIS/blob/main/README.md
https://publiclab.org/notes/sashae/06-26-2020/diy-satellite-ground-station
https://publiclab.org/notes/sashae/06-26-2020/diy-satellite-ground-station
https://amsat-uk.org/beginners/how-do-i-start/
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https://www.irts.ie/cgi/st.cgi?study
https://www.irts.ie/cgi/st.cgi?study
https://www.rtl-sdr.com/rtl-sdr-quick-start-guide/
https://www.nesdis.noaa.gov/s3/2022-05/PWR_SAB_071220212_As_Delivered-remediated.pdf
https://www.nesdis.noaa.gov/s3/2022-05/PWR_SAB_071220212_As_Delivered-remediated.pdf
https://www.nesdis.noaa.gov/s3/2022-05/PWR_SAB_071220212_As_Delivered-remediated.pdf
https://www.youtube.com/watch?v=rUwRt5qn-6U
https://www.youtube.com/watch?v=rUwRt5qn-6U
https://publiclab.org/notes/sashae/06-26-2020/diy-satellite-ground-station
https://www.rtl-sdr.com/a-simple-guide-to-setting-up-a-diy-noaa-weather-satellite-ground-station/
https://www.rtl-sdr.com/a-simple-guide-to-setting-up-a-diy-noaa-weather-satellite-ground-station/
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